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This is the operator’s manual for the Micro-g LaCoste Sea3
PiperPro Processing Software. The software provides
sophisticated data collection and processing. It also has analysis
capabilities, including the standard environmental gravity
corrections to help achieve mGal level gravity measurements.

For operation of the Sea3 gravity meter hardware, refer to the
appropriate hardware user’s manual.

System Requirements
PiperPro runs on any computer with the following minimal
standards:

Operating System: Vista, Windows 7, Windows 8.1, Windows 10
Free Hard Drive Space: 1 GB or greater
RAM: 2 GB or greater
Processor: Intel™ P3 or greater (AMD also works with

similar standards)
Processing Speed: 1 GHz or greater

Conventions
Dialog box menus, commands, dialog box titles, labels and
options are bolded text in the user instructions. WARNING and
IMPORTANT notes are highlighted in red.
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2. INSTALLATION

Sea3 PiperPro Software 2-1

Installation Procedure 2-1





Sea3 PiperPro Software
Licensed users of Sea3 PiperPro can download the latest Sea3
PiperPro software (Sea3_yy-mm-dd_hhmmAM/PM_installer.exe)
from:

http://www.microglacoste.com/Sea3/

After installation, check that the files listed in Table 2-1 are
present on the local machine. If you do not have all the listed
files and/or directories once PiperPro is installed, please contact
Micro-g LaCoste.

Table 2-1 Installation Files

Filename Description
Program Files\PiperPro\readme.txt Overview of installation procedures.
Program Files\PiperPro\Sea3Help.pdf This document.
Program
Files\PiperPro\bin\Sea3_yy-mm-dd_hhmmA
M/PM.exe

Main application.

gInfo\PiperProDisplay.ini Configuration information for
PiperPro.exe.

Program Files\PiperPro\License.txt Standard software licensing information.

Installation Procedure
NOTE Before beginning installation, be sure to uninstall any previous

version of Sea3 PiperPro.

● Double click the Install application
(Sea3_yy-mm-dd_hhmmAM/PM_installer.exe).
− Follow the displayed instructions.
− It is highly recommended that you accept ALL default

settings.
● Double click on the newly installed Sea3 PiperPro program

icon.
● Select “generate” when prompted.
− This creates a SysChk.bin file that is unique to this computer.
− Note where it is located on your local hard drive.
− Email this SysChk.bin to: support@microglacoste.com
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− Wait for us to send you PiperProPWinfo.bin. This usually
takes less than 24 hours during a normal business week.

NOTE The SysChk.bin files are unique for each computer, so please
send one file at a time.

● Upon receipt of PiperProPWInfo.bin, manually copy the file into
the newly created gInfo. (Usually c:\gInfo).

● Double click on the Sea3 PiperPro program icon.
− Select Install. (May not be required if password is

recognized automatically)
− You may be asked to point to the PiperProPWInfo.bin file on

your local hard drive.

IMPORTANT Due to details in the software protection of Sea3 PiperPro, if at
any time the user adds or removes hardware from the
computer, it may be necessary to obtain a new password file by
following the above steps.

● Next, create the directory c:\gData\PiperPro if it does not
already exist.
− This is the default location for all Sea3 PiperPro data.

You are now ready to run Sea3 PiperPro.
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3. SYSTEM SETTINGS

Local Configuration File 3-1
Local .ini File 3-1

Modify System Setting Parameters 3-1
Setup Tab 3-2

Serial Output Setup 3-3
Calibration Tab 3-4
Corrections Tab 3-5

Eötvös Correction 3-5
IGF Correction 3-6





Local Configuration File

Local .ini File

All processing parameters for the loaded data are stored in the
local PiperPro.ini file located in the same folder as the data.
Changes to this .ini file only affect the data in that folder when
reprocessed.

NOTE To save the processing parameters changes to the PiperPro.ini
file, select Save from the File menu. Note that the settings are
automatically saved when processing starts (Select Start from
the Reprocess menu).

Modify System Setting Parameters
The processing parameters may be modified from the System
menu and clicking Settings (or F3). There are three tab pages
(Setup, Calibration and Corrections) contained in the System
Settings dialog.

Figure 3-1 System Settings Dialog: Setup Tab Page
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Setup Tab

The Setup tab page configures the instrument setup parameters. Refer to
Table 3-1 for a description of each of the setup parameters. Figure 3-1
shows the Setup tab page.

Table 3-1 System Settings Dialog: Setup Tab Page Parameters and Descriptions

Section Parameter Description
Meter Name/ID Serial number of the meter.
Raw Gravity Window(s) Total seconds plotted for raw gravity. After this total has

been reached, graphs scroll horizontally.
Filtered Data Window(s) Total seconds plotted for one second data plots. After

this total has been reached, graphs scroll horizontally.

Filter Levels Checking the Levels box enables a 20Hz (for both
MGS-6 and TAGS-6 meter) to 5 second filter on the
levels data. If this is disabled, the levels are filtered to 1
Hz data instead. (This is only a graphical filter. This filter
is not applied to recorded data in files.

Exact Blackman
Filter (Gravity)

Checking the Exact Blackman Filter (Gravity) box
enables a FIR (Finite Impulse Response) Exact Blackman
filter on the 1 Hz gravity data. Refer to Appendix B for
the QC filter computation.

Window (s) The window text field is the filter length for the Exact
Blackman Filter.

File type DAT or TSoft Select the output file type. The DAT files are comma
delimited ASCII files that can be read using a
spreadsheet application. TSoft files are tab delimited
files, with detailed header and can be imported into the
TSoft reprocessing software.

Meter
Communication

Setup Click the Setup button to configure communication
settings.

GPS Off If no GPS is connected.
From Meter Meter connected to GPS.
From Vessel System computer connected to serial GPS. Click Port

Setup button to configure communication settings
GPS Time Stamp Grayed out for

Sea 3 systems
Not applicable for Sea 3 systems

Output file
Backup

Enabled Click Enabled to send the backup file to another
location.

Output Data to
Serial

Enable Click Enabled to send data to an external location
through the serial port. Click the Setup button to
configure communication settings and data format. Refer
to the Serial Output Section for additional information.
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Serial Output Setup

Under the System menu select the System Settings option to
access the Setup tab page where data can be configured to be
sent to an external location. In the Output Data to Serial
section, click Enable then click Setup to access the Serial
Output Setup dialog (Figure 3-2). Refer to Table 3-2 for a
description of each of the output options.

Figure 3-2 Serial Output Setup Dialog

Table 3-2 Serial Output Setup Table Description

Option Description
Port Settings Click Setup and configure the port settings.

Checksum Choose a checksum option.
String Width Choose a string width.
Field Delimiter Choose a field delimiter.
String Termination Choose a string termination.
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Calibration Tab

The Calibration tab page shows the current calibration of the
meter. The calibration factors change if the meter is serviced
and/or altered. Figure 3-3 shows the Calibration tab page. The
calibration parameters are described in Table 3-3.

Figure 3-3 System Settings Dialog: Calibration Tab Page

Table 3-3 System Settings Dialog: Calibration Tab Page Parameters and Descriptions

Section Parameter Description
Gravity Reference This is an offset for gravity. Add the absolute

value here for your location to offset the
incoming gravity. This is required for IGF
correction.

Meter Temperature Expected (°C) The expected meter temperature for the
current instrument. If the meter temperature
is not within ± ½ degree C, then a warning
pops up during data acquisition.

Gain / Zero Long/Cross Level
Meter Temperature
Meter Pressure
Beam
Spring Tension
Long/Cross Gyros

These are the calibration factors used to
convert the raw input values into their
correct units.

3 - 4 System Settings
Release 115-781-002A, Release Date 16 Feb 2022



Corrections Tab

Figure 3-4 System Settings Dialog: Corrections Tab Page

Use the Corrections Tab page to enable Eötvös and/or IGF
(International Gravity Formula, GRS80) correction and set the
value of gravity reference (Base tie). Figure 3-4 shows the
Corrections tab page. The other fields are used for
experimental purposes.

Eötvös Correction

Eötvös correction in milliGal:

Εcorr = 7.503 ν cos λ sin α + 0.004154v2

Where:
ν = ship’s speed in knots
λ= latitude
α= ship’s course heading (0° is due north, 90° is due east)
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IGF Correction

International Gravity Formula, GRS80:

λ = latitude
g is in milliGal
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Sea3 Main Window

Figure 4-1 Example Sea3 Main Window with Several Views Selected

The main Sea3 window (Figure 4-1) always displays the Sea3 Data view
(Figure 4-2). It is the main view used to convey meter status and cannot be
closed.

There are thirteen other selectable views available to the user:

● Filtered Gravity
● Environment
● Gyros
● Levels
● Corrections
● Platform Corrections
● Raw Spring Tension
● Raw Beam
● Filtered Channels
● Lag corrections
● Controls
● Navigation Plot
● Raw Serial Output
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Under the View menu, click on the desired view to toggle the view On/Off.
Figure 4-1 shows an example setup of the Sea3 main window with several
views selected.

Sea3's main window remembers and displays the last selected views and
their positions.

Use the Window menu, to choose Cascade or Tile layout style.

Sea3 Data View

Figure 4-2 Sea3 Data View

Figure 4-2 shows an example of the Sea3 Data view. Refer to Table 4-1 for
description of the Sea3 Data view parameters.

Table 4-1 Parameter Description of Sea3 Data View

Section Parameter Description
Setup Meter

Time (GMT)
Shows the meter number and the
current time (GMT).

Filtered Channels Filtered TC (CU)
Filtered QC Grav
(mGals)
Filtered ST (CU)

Provides information about the
current filtered total correction,
quality control gravity, and filtered
spring tension

Levels Long Level
Cross Level

Displays the current long and cross
level position values.

Environment Meter Temp (°C)
Meter Press (mbar)

Shows the current meter
temperature and pressure.

Meter ASCII Output Meter ASCII Output Displays the raw serial string
acquired from the meter.
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External GPS
Output

External GPS Output Displays the raw gps string acquired
from an  external gps source

Meter Status Meter Status This displays meter status
information: Clamped, Turning, and
Tracking

ONLINE
TURNING
UNCLAMP
CLAMP
TRACKING ON
TRACKING OFF

Use the system buttons to
communicate with the meter. The
meter can be placed in TURNING or
ONLINE mode or the operator can
CLAMP or UNCLAMP the meter.

Beam The current beam position is given
and shown on the dial.

Eötvös The Eötvös correction.
ST (CU) Spring Tension in counter units
IGF The IGF correction.

Filtered Gravity View

Figure 4-3  Filtered Gravity View

The Filtered Gravity view (Figure 4-3) displays the corrected gravity data.
The graph automatically resizes to fit all the data across the graph. The data
fit time range is set in the Window (s) parameter in the Filtered Data
section on the Setup tab page in the System Settings dialog. Click
Settings under the System menu. The graph scrolls when the data exceeds
the set range.
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Environment View

Figure 4-4 Environment View

The Environment view (Figure 4-4) displays the environmental data
received from the meter, which includes meter temperature and pressure,
beam position and VCC calculations.

The data fit time range is set in the Filtered Data Window (s) parameter
on the Setup tab page of the System Settings dialog. Click Settings under
the System menu.
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Levels View

Figure 4-5 Levels View

The Levels view (Figure 4-5) displays the level data received from the meter,
which includes long level and cross level. The levels data fit time range is set
in the Window (s) parameter in the Filtered Data section on the Setup tab
page in the System Settings dialog. Click Settings under the System
menu.
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Corrections View

Figure 4-6 Corrections View

The Corrections view (Figure 4-6) displays the Eötvös and IGF data
corrections received from the meter. Enable corrections from the
Corrections tab page under the System Settings dialog. Click Settings
under the System menu.
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Controls View

Figure 4-7 Controls View

The Controls view (Figure 4-7) shows real time meter status in a more
visual type display. Certain fields may not update, depending on your GPS
status.
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Navigation Plot View

Figure 4-8 Navigation Plot View

The Navigation Plot (Figure 4-8) plots the current run latitude and
longitude on a graph so you can see what your course has been. The latitude
and longitude max/min can be set using the lower text boxes or set to be
automatic. In order to update the min/max, click Update. The navigation
plot will not update if there is no GPS input or the meter is stationary.
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Filtered Channels View

Figure 4-9 Filtered Channels View

The Filtered Channels view Figure 4-9) displays the filtered spring tension
(ST), cross coupling (CC), and total correction (TC).

Gyros View

Figure 4-10 Gyros View

The Gyros view (Figure 4-10) displays the gyro data received from the meter
which includes the long gyro and cross gyro.
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Raw Beam View

Figure 4-11 Raw Beam View

The Raw Beam view (Figure 4-11) displays the raw 20 Hz beam position as
it was received from the meter. The graph automatically scrolls after a fixed
amount of time passes.

Raw Spring Tension View

Figure 4-12 Raw Spring Tension View

The Raw Spring Tension view (Figure 4-12) displays the raw 20 Hz spring
tension as it was received from the meter. The graph automatically scrolls
after a fixed amount of time passes.
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Lag Corrections View

Figure 4-13 Lag Corrections View

The Lag Corrections view ( Figure 4-13) displays the long and cross
accelerometer lag corrections calculated from the received gyro value.

Modifying The Views

Reset All Graphs

Selecting Reset All Graphs under the View menu, clear and resets all graphs.
Resetting the view(s) only clears the view, it does not clear the data from the
data files or filters.

Every view can also be cleared and reset by unselecting and reselecting the
view from the View menu.

Customize Graph Style

The graphic appearance can be customized by double clicking on the graph to
bring up the customization dialog. Figure 4-14 shows an example Filtered
Gravity Customization dialog. To display the default configuration, simply
close the graph and reopen it from the View menu
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Figure  4-14 Filtered Gravity Customization Dialog

IMPORTANT Viewing many graphic displays can slow down data processing.
Typically not an issue for the supplied laptops, however, user
supplied laptops must meet or exceed specifications of the
supplied laptops.

If your system does NOT have a good graphics card (>32mb
on-board memory) or the system is running slower than
anticipated, minimize the number of open views.

For a full screen view of the graph, click the Maximize button in the bottom
right corner of the Gravity Customization dialog. To close the maximize
view, press the Esc key.

To export the view, click the Export button in the bottom right corner of the
Gravity Customization dialog. Select the file type, destination and size then
click Export.
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Modify Y-Axis

To customize the y-axis for each graphic, from the System menu select
Graphics. In the Graphics Setup dialog set the Max and Min range for each
graphic. Refer to Section 07 Additional Menu Options, “Graphics” for detailed
information.
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Before acquiring new data, open the program and make sure the system settings
are set correctly for the meter as well as for the user preferences. From the
System menu select the Settings option. Once the acquisition has started, most of
these settings cannot be changed.

IMPORTANT The time on the PC Clock must be set to Coordinated Universal
Time (GMT), not local time, with daylight savings disabled.

To acquire new data:

● From the File menu select New.

● Then select the directory for the data to be stored when
prompted.

● If Output File Backup is enabled in the Setup tab of the
System Settings dialog, you will be asked to select the
secondary backup location and filename.

Directory Selection

It is recommended that you create a different directory for each new
acquisition especially if parameters change. The newly created directory not
only stores the data, but it also stores a new, local PiperPro.ini file.

This local PiperPro.ini file must accompany the data if it is moved (or
archived) because it contains the settings for that particular acquisition. The
default directory used at Microg LaCoste for storing all the data directories is
C:\gData\PiperPro. This directory can be created by the user after installation
if it does not already exist.
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Acquiring Data

Once a directory and file have been selected, Sea3 PiperPro begins receiving
data and updating the view windows. At this point, the system is storing
data.

IMPORTANT Sea3 data is stored in automatically named files consisting of
the date, meter, and meter ID (YYYY_MM_DD_MGS_XXX.DAT,
XXX – three digit meter ID).  There is one file per day.

The new Sea3 meter outputs raw data at 20Hz. The Sea3 PiperPro software
can record both 1Hz and 20Hz .DAT or .TSoft files.

The DAT files are space delimited plain ASCII files that can be read using a
spreadsheet application. TSoft files are tab-delimited files that have a
detailed and specific header and can be imported into the TSoft reprocessing
and analysis software.

Reset Graphs

Once the data is deemed acceptable, the meter should be set to Online.
Once data is being acquired, reset all the graphs views by selecting Reset
Graphs under the View menu.

Data Files

The 20 Hz raw data (*.txt files) is stored every time new data is acquired
from the meter (an option for Sea3 but a good practice to store the 20 Hz
*.txt file). The text output files (DAT or TSoft) are also updated once every
second.
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Sea3 Timing

Meter Data

The Sea3 meter outputs data at a rate of 20Hz. A data packet is a serial
ASCII string sent from the Sea3 meter that contains meter data such as
Gravity, Temperatures, Levels, etc. You can view the raw ASCII string in the
Meter ASCII Output located in the Sea3 Data window.

GPS Synchronization

The Sea3 timing box is equipped with a GPS unit. This GPS unit synchronizes
with the onboard rubidium clock if connected to an external antenna and a
valid GPS signal is attained. Once a GPS lock is attained, Sea3 PiperPro can
then synchronize the onboard rubidium clock to the GPS clock. To do this
select Synchronize Clock in System.

GPS Data

There are two ways to send GPS data to PiperPro.

The first option is to attach a GPS antenna to the GPS unit. When the signal
is locked, a NMEA RMC serial string is sent on the same serial line as the
meter data. This data is parsed inside Sea3 PiperPro and GPS data such as
date, time, latitude, longitude, course and speed is extracted. This data is
used to calculate corrections used in real time. This data is also stored into
the data file (DAT or TSoft). Set this option by selecting From Meter in the
Setup tab of System Settings dialog.

The second option for acquiring GPS data is to directly attach to the system
computer a serial line that transmits continuous 1Hz serial NMEA GPS strings.
There is no direct handshaking on this GPS serial line, so the data must be
continuously sent. The GPS data is parsed and GPS data such as date, time,
latitude, longitude, course and speed are extracted. This data is used to
calculate corrections used in real time. This data is also stored in the data
file. Set this option by selecting From Vessel in the Setup tab of System
Settings dialog. The settings for this serial port can be configured by clicking
the Port Setup button located next to the From Vessel option. The user
can also select either NMEA: V2.3+ or Pre-V2.3.

Currently there are three types of accepted NMEA GPS string formats: RMC,
GLL, and VTG.
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RMC

NMEA has its own version of essential GPS pvt (position, velocity, time) data.
It is called RMC, The Recommended Minimum, which will look similar to:

$GPRMC,123519,A,4807.038,N,01131.000,E,022.4,084.4,230394,003.1,W*6A

Where
RMC Recommended Minimum sentence C
123519 Fix taken at 12:35:19 UTC
A Status A=active or V=Void.
4807.038,N Latitude 48 deg 07.038' N
01131.000,E Longitude 11 deg 31.000' E
022.4 Speed over the ground in knots
084.4 Track angle in degrees True
230394 Date - 23rd of March 1994
003.1,W Magnetic Variation
*6A Checksum data

NOTE As of the 2.3 release of NMEA, there is a new field in the RMC
sentence at the end just prior to the checksum.

GLL

Geographic Latitude and Longitude is a holdover from Loran data. The string
should look similar to this:

$GPGLL,4916.45,N,12311.12,W,225444,A,*1D

Where
GLL Geographic position, Latitude and Longitude
4916.46,N Latitude 49 deg. 16.45 min. North
12311.12,W Longitude 123 deg. 11.12 min. West
225444 Fix taken at 22:54:44 UTC
A Data Active or V (void)
*1D Checksum data

NOTE As of the 2.3 release of NMEA, there is a new field in the GLL
sentence at the end just prior to the checksum.
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VTG

Velocity made good. The string should look similar to this:

$GPVTG,054.7,T,034.4,M,005.5,N,010.2,K*48

Where
VTG Track made good and ground speed
054.7,T True track made good (degrees)
034.4,M Magnetic track made good
005.5,N Ground speed, knots
010.2,K Ground speed, Kilometers per hour
*48 Checksum data

NOTE As of the 2.3 release of NMEA, there is a new field in the VTG
sentence at the end just prior to the checksum.

NOTE In order to get the required data needed for Sea 3 corrections,
RMC or both GLL and VTG are required.

Graphics
The user can:

● Change the graphics settings.
● Update the graphing windows by closing and reopening the

graphic window.
● Manipulate the graphs and locations.

While data is being received, the user can change the graphics by selecting
the Graphics options available in the System menu. Figure 5-1 shows an
example of the System menu. Refer to Section 07 Additional Menu Options
“Graphics” for additional information and example dialog.

To modify the graphic appearance, double click on any individual graph in the
Sea3 main window. Refer to Section 04 PiperPro

Acquiring Data 5 - 5
Release 115-781-002A, Release Date 16 Feb 2022

http://../Old%20Manual/Section%2006%20becomes%2007.doc#Sec7SystemGraphics
http://../Old%20Manual/Section%2006%20becomes%2007.doc#Sec7SystemGraphics
http://../Old%20Manual/Section%2004%20New%2004.doc#CustomizeGraphStyle


Figure 5-1 System menu selection list

Main Window And View “Customize Graph Style” for additional
information.
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Hardware Communication

Communicate With Meter

Refer to Figure 5-1 to see list of options available under the System menu.
The user can:

● Connect/Disconnect
● Clamp/Unclamp the meter
● Stop Clamping/Unclamping
● Synchronize Clock/Use Internal Clock
● Set mode Turning/Online
● Sync Pc to GPS Time
● Set Limits
● Moving Spring tension
● Set ST tracking Parameters
● Set Cross Coupling Coefficients
● Send Custom Command
● Terminal Window
● Reset Meter CPU

The meter sends out a status line to inform Sea 3 of its current status. Sea3
PiperPro automatically enables and disables options based on the status of
the meter.

View Meter Status

Status of the meter can be viewed from the status bar or from the Sea3
Data window.

Status Bar

The status bar, shown in Figure 5-2, can display a variety of status indicators
and is located in the bottom frame of the Sea3 main application window.

Figure 5-2 Status Bar

The status bar can display the following information:

● The current open file.
● Whether the meter is clamped or unclamped.
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● Whether data is synced to GPS.
● Whether the data is set to Online or Turning.
● Whether Feedback is On or Off.

Sea3 PiperPro Data Window

The meter status is also indicated in the Sea3 Data window. Refer to Figure
5-3.

Figure 5-3 Meter Status Displayed in PiperPro Data Window
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6. POST-PROCESSING

Starting Sea3 and the Global .ini File 6-1

Loading Existing Data 6-1
Load Types 6-3

Quick 6-3
Visual 6-3

Post Processing Data 6-4
Clearing Graph Data 6-4
Customizing Graph Data 6-4





This section describes how to reprocess data that has already been acquired.
Acquiring data in real time is discussed below.

Starting Sea3 and the Global .ini File

Start Sea3 PiperPro by double clicking on the Sea3 PiperPro icon. The Sea3
main window shown in Figure 6-1 will appear.

NOTE No data is loaded at this point. Any changes made in Settings
affect the global .ini file. If you change and save any settings at
this point, the software will warn you that you are making a
global change that affects all future data acquisition.

Refer to Section 03 System Settings “Local .ini File” for more information.

Figure 6-1 Open Project
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Loading Existing Data
To load existing data:

−From the File menu select Load.
−The Select Data File dialog opens. Refer to Figure 6-2.

Figure 6-2 Select Data File: File

Extension Selection

● Navigate to the desired directory.
− Select the file for the desired day.
− The file extensions vary depending upon the system and

data. Figure 6-2 shows an example selection drop down list.

● The Load Type dialog shown in Figure 6-3 appears.
− Select the load type (Quick or Visual).Then click OK.
− Refer to the Load Types section below for additional

information.

● The Selection Configuration File browser dialog opens
− Navigate to the desired directory.
− Select the *.ini file for the current configuration file
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Figure 6-3 Load Type Dialog

Load Types

There are two different ways of loading and processing files.

Quick

Quick load loads and processes the entire data set that you
select and then graphs the data. This is the quickest way of
loading and processing the data.

Visual

Visual load loads and graphs the data simultaneously. This is a
much slower approach, but it allows the user to see all the data
in detail as it is processed.

In the latest version of Sea3 PiperPro (1.20.11.23.10.34),  if the data you are
trying to reprocess data recorded with an older version (1.200724 or earlier), a
warning message will appear (inset the Figure below) and the process will abort
(Figure 6-4)

Figure 6-4 Load data version warning
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Post Processing Data

To start loading and re-processing data, select Start from the Reprocess
menu.

If Quick load was selected, then all the data is initially loaded before the
graphs and windows are updated.

If Visual load was selected, then the processing can be stopped or
paused at any time, and the user-set parameters can be changed at
any time.

The user can change any parameters by selecting Settings from the
System menu (or F3). Refer to Section 03 System Settings “Modify
System Setting Parameters” for more information. To begin processing
again, select Start from the Reprocess menu (or F5). The load type
cannot be changed once the file has begun processing. To change load
type, reload the file by selecting Load from the File menu.

During a Visual Load, the user can pause by selecting Pause from the
Reprocess menu. The user can then select Start (to restart the
process) or Step (to step through the process) from the Reprocess
menu.

Clearing Graph Data

Every graph can be closed and reopened from the View menu. Closing and
reopening a graph view clears the data from the graph window. You can also
clear all data from all graph windows by selecting Reset All Graphs under
the View menu.

Customizing Graph Data

The graphs can also be customized by clicking anywhere on the graph to
bring up the customization dialog. See Section 04 PiperPro Main Window And
Views “Customize Graph Style” for detailed information.

Each graph’s y-axis can also be customized from within the Graphics Setup
dialog. To access the Graphics Setup dialog, select Graphics from the
System menu. These values are also saved to the *.ini text project file. See
Section 07 Additional Menu Options “Graphics” for additional details and an
example dialog.

To reset the graph after customizations, the user can simply close the graph
and reopen it.
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IMPORTANT Viewing many graphic displays can significantly slow down data
processing.

If your system does NOT have a good graphics card (>32mb
on-board memory) or the system is running slower than
anticipated, minimize the number of open views.
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7. ADDITIONAL MENU OPTIONS

File 7-1

Edit 7-1

System 7-2

Reprocess 7-6

View 7-7

Window 7-8

Help 7-9





File

New

The New option creates a new project file from the current
System | Settings. Once an output directory has been selected,
all the project files are created and data acquisition begins.

Load

The Load option loads an existing file. The user can choose
Quick load or Visual load. The Quick load loads the entire
selected data set and then graphs the data. This is the quickest
way of loading the data. The Visual load loads and graphs the
data simultaneously. This is a much slower approach, but loads
everything sequentially.

Close

The Close option closes an opened file. Upon closing, the main
PiperPro.ini file is reloaded.

Save

The Save option saves the current file. PiperPro warns the user
if they are saving over the main PiperPro.ini file that is located
in the software installation directory.

Exit

The Exit option exits the program.

Edit

Time Offset

The Time Offset option allows application of a time shift in the
event that the computer time was not set to the correct time. To
calculate the offset, change the True Start Time to the correct
time (the time that should have been). Check the time offset as
listed in the grayed edit box. If the time offset is correct, check
the Apply Time Offset option to make the time offset effective
during processing. This option only pertains to reprocessing of
data. Refer to Figure 7-1.
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Figure 7-1 Time Offset Dialog

Processing Rate

The Processing Rate sets the processing rate. This option only
pertains to reprocessing of data. Some computers are slower
and thus the software allows for more reprocessing time to
reduce the chances of a computer crash or system overload.

System

Settings

The Settings option allows changes to any of the system
settings including Setup, Calibration and Corrections. These
settings are unavailable during real-time acquisition, but can be
altered before acquisition and reprocessing.

Graphics

The Graphics option opens the Graphics Setup dialog which
allows customization of the y-axis scale for the Gravity
Filtered, Environment, Levels and Corrections, Spring
Tension, Filtered Channels and Gyros graphs. Each graph
can be set up independently to either be auto-scaled or
user-scaled.

Figure 7-2 shows an example of the Graphics Setup dialog. These values can be
saved to the *.ini file so the user does not have to reload them each time they start
a new acquisition or reprocess the data.

The graphic style is modified in the customization dialog for each graph. Access the
customization dialog by double clicking on the graph. Refer to Section 04 Sea3
PiperPro Main Window And Views, “Customize Graph Style” for more information.
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Figure 7-2 Graphics Setup Dialog
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Connect

For this release, connect is an automated feature. It is a
placeholder for a future usability feature.

Disconnect

Disconnects and closes the file. Currently this is a placeholder
for a future usability feature.

Clamp

The Clamp option clamps the meter.

Unclamp

The Unclamp option unclamps the meter.

Stop Clamping/Unclamping

The Stop Clamping/Unclamping option tells the meter to stop
clamping or unclamping.

Move Spring Tension

Use this option to move the spring tension.

Set ST Tracking Parameters

Use this option to set the ST tracking parameters.

Set Cross Coupling Coefficients

Use this option to set the cross coupling coefficients.

Send Custom Command

Use this option to send a custom command

Online

The Online option tells the meter that you are online. This is
the ideal mode for acquiring data.
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Turning

The Turning option tells the meter that you are turning. This
mode is usually used while the aircraft/ship is turning and is not
on a stable and direct path.

Set Limits

The Set Limits option tells the meter to set its internal limits.

Synchronize Clock

The Synchronize Clock option tells the meter to synchronize
the onboard clock with the GPS clock. Once synchronization is
achieved, the meter outputs a timestamp with the ASCII serial
data string. This only pertains to TAGS-6 systems. .

Turning Sound Enabled

On the TAGS-6 system, an audible sound (beep) is heard while
in turn mode.

Sync PC to GPS Time

If you have valid GPS and administrator rights to set the
computer time, this will sync the computer clock to the GPS
time.

Terminal Window

In the Terminal window, (Figure 73) type commands to be sent
to the meter in the text box, then click Send. The “Connect”
button disconnects the serial port connection,it will change to
“Disconnect” when “Connect” is clicked. The Exit button closes
the Terminal window and disconnects from the serial port if
necessary.

Reset Meter CPU

Reboot the instrument's firmware.
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Figure 7-3 Terminal Window

Reprocess

Start

The Start option starts the processing in both post-processing
and real-time acquisition.

Stop

The Stop option stops all processing in post-processing or
real-time acquisition mode.

Pause

The Pause option pauses processing and can only be used in
post-processing mode.

Step

The Step option processes data step-by-step in post-processing
mode only.

7 - 6 Additional Menu Options
Release 115-781-002A, Release Date 16 Feb 2022



View

The View menu allows all available graphs to be opened, closed or reset. If
the graph is currently visible, there is a check mark next to the graph in the
View menu list. Detailed description about the graphs can be found in
Section 04 “PiperPro Main Windows And Views”.

Filtered Gravity

Toggles Filtered Gravity graph Open/Close.

Environment

Toggles Environment graph Open/Close.

Gyros

Toggles Gyros graph Open/Close

Levels

Toggles Level graph Open/Close.

Corrections

Toggles Corrections graph Open/Close.

Platform Corrections

Toggles Platform Corrections Open/Close

Raw Spring Tension

Toggles Raw Spring Tension View Open/Close.

Raw Beam

Toggles Raw Beam View Open/Close.

Filtered Channels

Toggle Filtered Channels (ST, CC, TC) View Open/Close.

Lag Corrections

Toggles Lag Corrections (Long & Cross) View Open/Close.
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Controls

Toggles Control View Open/Close.

Navigation Plot

Toggles Navigation Plot Open/Close.

Raw Serial output

Toggles Serial output View Open/Close.

Reset All Graphs

Resets all graphs.

Toolbar

Toggles Toolbar ON/OFF.

Status Bar

Toggles Status Bar ON/OFF.

Full Screen

Toggles Full Screen mode ON/OFF.

NOTE When in full screen mode and the Status Bar, Toolbar, and
Menu are not visible they can be enabled by pressing the F12
key.

Window

The Windows menu lets users change the display style and also lists the
currently open views.

Cascade

Displays the selected graphs in cascade mode.

Tile

Displays the selected graphs in tile mode.
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Help

Sea3 Help

This will Open the PDF version of this manual.

About Sea3

Opens the About Sea3 dialog showing the current Sea3 version
information.

Update Firmware

WARNING Only use this option under the direction of a Microg LaCoste
engineer.

A firmware upgrade is sent when required. Follow the installation procedure
under the direction of a Microg LaCoste engineer.

Clicking on Update Firmware brings up the PIC32 Bootloader
Application v1.2 dialog.  Refer to Figure 7-4.

1. Click Connect.
2. Then click Load Hex File.

− Select the upgrade firmware file in the displayed browser
window.

− Then click Open.
3. Click Erase Program Verify.
4. Click Run Application.

− The Update Firmware program will automatically close upon completion.
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Figure 7-4 PIC32 Bootloader Application V1.2 Dialog

Configure Novatel

Not applicable to Sea 3.

Clear Error Log File

The Clear Error Log File option clears the error log.

Clear Event Log File

The Clear Event Log File option clears the event log.
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License Information
Licensed users of Sea3 PiperPro are entitled to three install
platforms with the Main License. Additional installations,
including support, are purchased one seat at a time directly
from Micro-g LaCoste. If your institution or company requires
PiperPro Processing software to run on more than three
platforms, please contact Micro-g LaCoste directly or visit our
website, www.microglacoste.com, for more information.

Support

Contact

Questions concerning the operation of the PiperPro Processing
software and any problems using PiperPro please contact
Customer Service at support@microglacoste.com.

Expect a response via email or phone call within forty-eight
hours of your inquiry.

Support Request

Provide complete detailed information to help us respond with a
more accurate and timely response. Include software release
version (select About Sea3… under the Help menu), a
scenario description and list of steps to recreate the problem.

Maintenance
Periodically Micro-g LaCoste posts an upgrade “patch” for the
Sea3 Processing software on the website. These patches are
posted without notification so check back every few weeks to
get the latest patch if applicable.
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This appendix provides a description of the 1-second .DAT file format of the current
MGL Sea-III marine gravity systems and the information needed to re-compute
gravity from the raw data channels.  The current data format contains legacy
channels which will be removed in future release and new channels may be added.
Any changes in future releases will be documented accordingly.

Data Formats

The 1-second .DAT file contains a header that provides general information such as
meter ID, data acquisition software version, date, time and system setting
parameters.  The header lines start with the symbol /.  The header information
ends with a line containing only the symbol, /.

The data channel names start after the line:
/ Column Headers:

The software version 1.2010301517 or newer is different from previous versions,
such as 1.1905311519, in how gravity is constructed.  However, they contain
identical data channels of a total of 56.

The total number of header lines vary in DAT files from different versions of Sea-III
data acquisition software.  Compared with previous versions, the version after
1.2010301517 contains two extra lines in the header:
/ Cross Gyro Lag Scale Factor:
/ Long Gyro Lag Scale Factor:

Channel Descriptions

There are 56 channels in the 1 Hz DAT file.  Some of the SEA-III output data
channels are included for backward compatibility with AirSea II and/or MGS6 data
formats. These are indicated with asterisks (*), and will be removed in future
releases. The channel names (listed after the line / Column Header:) are
self-explanatory. Only a brief description of the record format, unit, and derivation
(if needed) is given.

1. Year:  YYYY
2. Month: mm
3. Day:  dd
4. Hour: HH
5. Minute:  MM
6. Second: SS
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7. MilliSec: sss (Channels 1-7 give the timestamp of the data record)

8. RawGravity(mGals): Raw gravity, no corrections, no filtering. Formula for
version newer than 1.2010301517:

RawGravity = STCoefficient*(ST + BVCorr + CCCorr).

For previous releases, such a version 1.1905311519, the formula is:
RawGravity = STCoefficient*ST + BVCorr + CCCorr.

Formulas for BVCorr and CCCorr are described later.

9. CorrGravity(mGals): is RawGravity (channel 8) with corrections applied, no
filtering. Formula:

CorrGravity = RawGravity + LongGyroCorr + CrossGyroCorr +
EotvosCorr* + IGFCorr*.

* The EotvosCorr and IGFCorr are applied if enabled by the user.

10. FilterWindow(s): Sea3 PiperPro low-pass QC filter, in seconds.

11. FiltCorrGravity(mGals): Filtered CorrGravity (channel 9), with filter
described in channel 10.

12. LongLevel (Gals):  Platform long axis level (accelerometer)
13. CrossLevel (Gals): Platform cross axis level (accelerometer)

14. LongLevelSquared (Gals): The square of platform long axis level (12), in

. Note that the squaring is done in 20Hz, then anti-alias filtered and
down sampled to 1Hz, so it won’t exactly equal to the square of channel 12.

15. CrossLevelSquared (Gals): The square of platform long axis level (13), in

. Note that the squaring is done in 20Hz, then anti-alias filtered and
down sampled to 1Hz, so it won’t exactly equal to the square of channel 13.

16. MeterTemp (°C): meter internal temperature

17. MeterPres (mbar): meter internal pressure

18. Beam (V):  Meter Beam position in Volts.
19. Beam750K*: Meter beam position, in volts × 750000. This field is for

backwards compatibility with AirSeaII systems and will be removed in future
release.
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20. VCC: VCC cross-coupling channel, unitless.

21. EötvösCorr (mGals): Eötvös correction (from GPS).

22. IGFCorr (mGals): International Gravity (Normal Gravity) Formula (latitude
from GPS) correction.

23. VerMotionCorr (mGals)*: Vertical motion correction. Will be removed in
future release.

24. HorMotionLongCorr (mGals)*: Horizontal motion (long axis) correction.
Will be removed in future release.

25. HorMotionCrossCorr (mGal)*: Horizontal motion (cross axis) correction.
Will be removed in future release.

26. VerMotionStdDev (Gals)*: Vertical motion standard deviation. Will be
removed in future release.

27. HorMotionLongStdDev (Gals)*: Horizontal motion (long axis) standard
deviation, will be removed in future release.

28. HorMotionCrossStdDev (Gals)*: Horizontal motion (cross axis) standard
deviation. Will be removed in future release.

29. Latitude (dd, +N): Latitude in decimal degrees from GPS
30. Longitude (dd, +E): Longitude in decimal degrees from GPS

31. Course (deg):  vessel course direction in decimal degrees from geographical,
computed from GPS. Compass convention: North 0 degree and East 90
degree.

32. Speed (kn): vessel total speed in knots, computed from GPS.

33. Meter Status (Byte): Meter status, see Table A-1 to decode.

34. Timer (ms): Internal diagnostic only

35. VE: VE cross-coupling channel, unitless
36. AL: AL cross-coupling channel, unitless
37. AX: AX cross-coupling channel, unitless
38. AX2: AX2 cross-coupling channel, unitless

39. ST: Spring Tension, in ST Counter Unit.
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40. CrossGyro: angular velocity in deg/s

41. LongGyro: angular velocity in deg/s

42. ZGyro vertical gyro angular rate, in deg/s (note: for
future use, not used at present).

43. CrossGyroCorr (mGals): Cross gyro correction
44. LongGyroCorr (mGals): Long gyro correction

45.FiltCrossGyroCorr (mGals): filtered channel 43, filter defined in channel 10
applied.

46.FiltLongGyroCorr (mGals): filtered channel 44, filter defined in channel 10
applied.

47.FiltST:  filtered ST  (channel 39) filter defined in channel 10 applied.

48. FiltTC: Filtered total correction. Filter defined in channel 10 applied.  Unit in
mGals.  Total correction is a legacy terminology and will be removed in future
release. Refer to Appendix A for more details.

49. FiltCorrQCGravity*: The same as FiltCorrGravity, in mGals. Will be
removed in future release.

50. FiltVCC: Filtered VCC (channel 20) cross-coupling, unitless. Filter described
in field 10 applied.

51. FiltEötvösCorr(mGals): Filtered channel 21. Filter described in field 10
applied.

52. FiltIGFCorr(mGals): Filtered channel 22. Filter described in field 10 applied.

53. FiltVerMotionCorr (mGals)*: Filtered vertical motion correction (channel
23). Filter described in field 10 applied. Will be removed in future release.

54. FiltHorMotionLongCorr (mGals)*: Filtered Horizontal motion (long axis)
correction (Channel 24), with the filter described in field 10 applied. Will be
removed in future release.

55. FiltHorMotionCrossCorr (mGals)*: Filtered Horizontal motion (cross axis)
correction (channel 25) with the filter described in field 10 applied. Will be
removed in future release.

56. GPSTime(HHMMSS): time stamp from the most recent GPS data received.
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Table A-1 Meter status bits

BIT FUNCTION DEC
0 CLAMPED (firmware thinks it is clamped) 1
1 UNCLAMPED (firmware thinks it is unclamped) 2
2 PPS_SYNC (firmware thinks it got a proper GPS sync) (not applicable

for Sea3)
4

3 TURNING_MODE (1 = turning mode on, 0 = turning mode off) (not
applicable for Sea3)

8

4 FEEDBACK (feedback closed loop is enabled) 16
5 Not used 32
6 REPEATED DATA LINE (PiperPro sets or clears this bit) 64
7 GPS Valid (PiperPro sets or clears this bit) 128
8 INTERNAL_TIMING MODE (1 == ON, 0 == OFF) 256
9 ST_TRACKING_ENABLED 512
10 ST TRACKING ERROR (limit switch) 1024
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Computing Gravity from Raw Data in the 1HZ DAT File

Raw Gravity

For versions newer than 1.2010301517, the raw gravity is computed as:

RawGravity = STCoefficient*(ST + BVCorr + CCCorr) (1)

For previous versions:

RawGravity = STCoefficient*ST + BVCorr + CCCorr (2)

Where:

STCoefficient: the spring tension coefficient that converts the spring tension
counter unit into mGal.  It is found in the [Spring] section of the .ini file.

BVCorr: Beam Velocity Correction which is calculated as:

BVCorr = BeamVelocity*(p0+p1*Beam+p2*Beam^2) + q1* Beam + q2* Beam^2
(3)

The coefficients p0, p1, p2, q1 and q2 are in the [AirSeaCalibrations] of the ini
file. The BeamVelocity in the version 1.2010301517 or newer is calculated using the
central difference (3-point) of the beam position.

BeamVelocity = (Beam(k+1) – Beam(k-1))/(2*dt) (4)

The previous versions use two-point differences of the Beam position.

BeamVelocity = (Beam(k) – Beam(k-1))/dt (5)

Where dt = 1 for 1Hz data.

CCCorr: cross-coupling correction which is computed as:

CCCorr = VCCCoefficient*VCC + VECoefficient*VE + ALCoefficient*AL +
AXCoefficient*AX + AX2Coefficient*AX2 (6)
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The coefficients are in the [AirSeaCalibrations] of the ini file.

In future releases, the cross-coupling channels will include the scaled
LongLevelSquared and CrossLevelSquared, which will be terms L2 and X2.

Corrected Gravity

CorrGravity = RawGravity + LongGyroCorr + CrossGyroCorr + EotvosCorr
+ IGFCorr (7)

The EotvosCorr and IGFCorr are applied if enabled by the user in the ini file.

Total Correction (TC)

The Total Correction (TC) is a legacy terminology carried from AirSeaII, where

TC = Beam Scale factor * beam velocity + CC (8)

In the Sea-III system release before version 1.2010301517, the total correction is:

TC = BVCorr + CCCorr (9)

In spring tension counter units.

In future releases, the TC channel will be removed and instead BVCorr and CCCorr
will be included in the data channels.
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APPENDIX B QC FILTER COMPUTATION





Assume the QC filter is set to L seconds (usually 120 or 180 seconds).  The FIR
filter will be 2L+1 seconds long, with a nominal cutoff period of 2L seconds.

First, calculate the weights for an ideal FIR low-pass filter with cutoff at 2L seconds,
length 2L+1:

𝑓(𝑘) =  1
𝐿 𝑠𝑖𝑛𝑐 1

𝐿 (𝑘 − 1 − 𝐿)( ) ,  𝑘 = 1,  2𝐿 + 1 

The sinc function is defined as

Next, calculate the weights for an Exact Blackman window of length 2L+1.  The
equation for the window weights is

Apply the window function to the filter weights:

𝐹(𝑘) =  𝑤(𝑘)𝑓(𝑘),  𝑘 =  1,  2𝐿 + 1

Finally, normalize so that the sum of the filter weights is 1:

𝐺(𝑘) =  𝐹(𝑘)

𝑖=1

2𝐿+1

∑ 𝐹(𝑖)

G(k) is the final filter to be applied by convolution.
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